About This Particular Macintosh: About the personal computing experience.
Cover Art
Copyright © 2012 Grant Osborne. We need new cover art each month. Write to us!

The ATPM Staff

Publisher/Editor: Michael Tsai
Managing Editor: Christopher Turner
Reviews Editor: Paul Fatula
Web Editor: Lee Bennett
Copy Editors: Chris Lawson, Linus Ly, Ellyn Ritterskamp, Brooke Smith, Vacant

Webmaster: Michael Tsai
Beta Testers: The Staff
Contributing Editors: Eric Blair, Ed Eubanks Jr., Matthew Glidden, Andrew Kator, Robert Paul Leitao, Wes Meltzer, David Ozab, Sylvester Roque, Mark Tennent, Evan Trent, Frank H. Wu, Vacant

1 http://www.basenotes.net
2 mailto:cover-art@atpm.com
3 http://mjtsai.com
4 http://www.retophisch.com
5 mailto:pfatula@atpm.com
6 http://albj.net/
7 http://chrislawson.net
8 http://qaptainqwerty.blogspot.com
9 http://www.ritterskoop.org
10 http://twitter.com/oharabrooks
11 http://mjtsai.com
12 mailto:editor@atpm.com
13 http://www.raoli.com
14 http://www.eubanksconsulting.net
15 mailto:mglidden@atpm.com
16 http://andrew.katorlegaz.com
17 http://twitter.com/PostsAtEventide
18 http://www.wesmeltzer.com
19 http://fatherhoodetc.wordpress.com
20 mailto:sroque@atpm.com
21 http://www.tennent.co.uk
22 http://www.symphonysound.com
23 mailto:fwu@atpm.com
Artwork & Design

Layout and Design  Michael Tsai
Web Design  Simon Griffer
Cartoonists  Matt Johnson, Linus Ly, Grant Osborne
Blue Apple Icons  Mark Robinson
Other Art  RD Novo
Graphics Director  Vacant

Emeritus
RD Novo, Robert Madill, Belinda Wagner, Jamal Ghandour, Edward Goss, Tom Iovino, Daniel Chvatik, Mike Shields, Gregory Tetrauld, Raena Armitage, Johann Campbell, Ted Goranson, Charles Ross.

Contributors
Chris Albertson, Lee Bennett, Mike Grossman, Robert Paul Leitao, Linus Ly, Grant Osborne, David Ozab, Narcis Parfenti, Ellyn Ritterskamp, Sylvester Roque, Cyrus Roton, Mark Tennent, Dave Trautman, Christopher Turner, Macintosh users like you.

Subscriptions
Sign up for free subscriptions using the Web form.

Where to Find ATPM
Online and downloadable issues are available at the ATPM Web Site. ATPM is a product of ATPM, Inc. © 1995–2012. All Rights Reserved. ISSN: 1093-2009.

Production Tools
Acorn, Apache, AppleScript, BBEdit, Docutils, DropDMG, FileMaker Pro, Git, GraphicConverter, E\TeX, make, Mailman, MySQL, Name Mangler, optipng, PyMesh, PyObjC, Python, rsync, Snapz Pro X, ssh.

Reprints
Articles, original art, and desktop pictures may not be reproduced without the express permission of the author or artist, unless otherwise noted. You may, however, print or distribute copies of this issue of ATPM as a whole, provided that it is not modified in any way. Authors may be contacted through ATPM’s editorial staff, or at their e-mail addresses, when provided.

Legal Stuff
About This Particular Macintosh may be uploaded to any online area or included on a CD-ROM compilation, so long as the file remains intact and unaltered, but all other rights are reserved. All information contained in this issue is correct to the best of our knowledge. The opinions expressed in ATPM are not necessarily those of the entire ATPM staff. Product and company names and logos may be registered trademarks of their respective companies. Thank you for reading this far, and we hope that the rest of the magazine is more interesting than this.

Thanks for reading ATPM.
About This Particular Macintosh has been free since 1995, and we intend to keep it that way. Our editors and staff are volunteers with real jobs who believe in the Macintosh way of computing. We don’t make a profit, nor do we plan to. Our aim is to produce a fiercely independent magazine, with multiple formats designed for easy reading rather than showing ads. The views expressed in these pages have always been our own, and to help prove it we do not accept direct sponsorships or advertising. We do, however, need to pay for our Web site and other expenses, so we rely on minimal advertising, sold indirectly via Google and Yahoo, as well as the support of ATPM readers who shop at Amazon.com\(^1\) using our link.

\(^1\)http://www.amazon.com/exec/obidos/redirect-home/aboutthisparticul
Welcome to the February issue of About This Particular Macintosh! We begin this month with a brief look at Apple’s results for the December quarter. For those of us who use Apple products, the results reveal that we have a lot more company. In this one quarter, around 60 million iOS devices were sold.

**Apple’s December Quarter Results**

For the 14-week period ended December 31, 2011, Apple reported record revenue of $46.33 billion and record earnings per share of $13.87. Revenue rose 73%, and earnings per share rose 116% over the prior-year results.

In response to the outstanding December quarter performance, Apple’s market capitalization (the sum value of the company’s outstanding shares) catapulted to over $410 billion, making Apple the most highly valued company in the land. At press time, Apple’s market capitalization is about $417 billion versus about $245 billion for Microsoft and $221 billion for IBM. Apple’s first big rival was IBM. Apple’s second big rival was Microsoft. Within the next year, Apple’s value may equal or exceed the value of the company’s two former rivals combined. Apple’s biggest rival today does not have a corporate name. Apple now competes with capacity constraints to meet global demand for the company’s popular products.

To put this level of success in perspective, Apple’s December quarter revenue of $46.33 billion was greater than the company’s total annual revenue of $42.905 billion in the fiscal year that ended in September 2009. Over a three-year period ending this September, Apple will grow four times in size.

**The iPhone**

Despite early concerns that the iPhone 4S did not represent a conspicuous change in the technology consumers might have expected in the latest iPhone refresh, iPhone unit sales rose 128% to over 37 million units in the December quarter. Siri, Apple’s “intelligent personal assistant,” has become a big hit among iPhone 4S handset owners. Powered by the A5 chip, the iPhone 4S handset was the clear winner among the smartphone choices available to US consumers in the period.

**The Macintosh**

In the December quarter, Apple sold nearly 5.2 million Macintosh personal computers. For the second consecutive quarter, Apple’s global network of retail stores sold well over 1 million Macs with 50% of sales through the stores to customers new to the Macintosh platform. The Mac’s 26% unit sales gain defied the slowing pace of global PC sales.

**The iPad**

The iPad 2’s biggest competition in the December quarter came not from another tablet-style device. The iPad’s competition was customer expectations of a late winter/early spring launch of the much anticipated iPad 3. In the quarter, Apple sold over 15.4 million iPads with year-over-year sales growth of 111%. At this time, the global sales potential of the iPad cannot be reasonably determined.

**Looking Beyond the Numbers**

Numbers can tell a story. But the big story of Apple’s success is how the company’s approach to product innovation has changed the way we communicate with one another and the ways in which we access news and information from around the world.

Although Apple is now among the world’s largest and most successful enterprises, the company’s success is due to the millions of people who use Apple products each and every day. At ATPM, we chronicle the “personal computing experience.” We’d like to hear how Apple-branded devices have enhanced your computing life. Success comes in different forms and sizes. How are Apple products helping you succeed each day in the business of life? Please send your story to editor@atpm.com.

Our February issue includes:

**MacMuser**: The Best and Worst Christmas Presents

This month, Mark Tennent muses the Galaxy Tab, hard drive warranties, and Baconnaise.

---

1[^1]

**PEBKAC**²: The Normals’ View of Apple and the iPhone
Tech-heads should realize that their view of Apple and the iPhone is very different from that of normal folks.

**Segments: An Achievable Dream**³
Dave Trautman is back with more tales of his Macintosh computing experience.

**Segments: Digital > Analog > Digital**⁴
A plea to keep QR codes on paper where they belong.

**Segments: Smart Move?**⁵
I want iPhone.

**How To: Create Your Own iPhone Ringtones**⁶
Custom iPhone ringtones do not require paying Apple a dollar each, or buying specialized software to do the job. You probably already have all the software necessary to make them yourself.

**Desktop Pictures: From ATPM Readers**⁷
Four ATPM readers provided this month’s photos.

**The Spinning Beachball**⁸
In a paperless society, dogs still eat homework.

**Review: The Information Diet**⁹: A Case for Conscious Consumption
Just as there is junk food, there is junk information. Learn how to resist it.

**Review: MacJournal 6.0**¹⁰
David Ozab has high marks for this powerful, flexible, and easy-to-use journaling environment.

---

²http://www.atpm.com/18.02/pebkac.shtml
³http://www.atpm.com/18.02/segments-achievable-dream.shtml
⁴http://www.atpm.com/18.02/segments-digital-analog.shtml
⁵http://www.atpm.com/18.02/segments-smart-move.shtml
⁶http://www.atpm.com/18.02/create-iphone-ringtones.shtml
⁷http://www.atpm.com/18.02/desktop-pictures.shtml
⁸http://www.atpm.com/18.02/spinning-beachball.shtml
⁹http://www.atpm.com/18.02/information-diet.shtml
¹⁰http://www.atpm.com/18.02/macjournal.shtml

¹¹http://www.postseventide.com
¹²http://www.theipadchronicles.com
E-Mail

AAPL Dividend
Thank you for another great issue of ATPM. I enjoy reading every issue even when it only seems to talk about the iPhone.

But I have a question that I hope you can answer. I’ve never understood the talk about Apple and its stock. Your latest issue mentions “the company expects earnings for the 14-week period in excess of $11 per share.” I happen to own some Apple stock, and I know there is only one type of stock available from them, and Apple has never paid a dividend on their stock, so how and why is this $11 per share figure valid, and why is it stated at all? The stock rises and the stock falls, but there are no dividends. Maybe this is a subject you could consider talking a little about in a future issue. Thank you and keep up the great work.

—Claude Nolan

As you point out, Apple does not currently pay a quarterly dividend. Although there is much speculation that the company will return to a regular dividend program in 2012 or 2013, the last regular dividend paid by Apple was in late 1995 and prior to the return of Steve Jobs to the company.

At present, the only way for Apple to increase shareholder wealth, since a dividend is not paid, is through share price appreciation. Although many factors including overall market conditions impact the share price, earnings and earnings growth are the primary catalysts for share price appreciation. Earnings growth and the rate of earnings growth are important for current Apple shareholders and prospective shareholders evaluating the stock.

According to Yahoo! Finance, the current Wall Street 1-year price target is $505.96 against a closing price today of $411.23. In contrast, my current 12-month target price, published in late October, is $640 based on expectations of earnings per share growth of 66%.

Because Apple’s earnings per share performance drives Wall Street price targets, it’s important to mention when discussing the company’s continuing success. I like the idea of covering the topic in a more comprehensive way in a future issue of ATPM, and I will discuss that with Michael and the editors. Please let me know if this response adequately addresses your question or if more information is desired.

—Robert Paul Leitao

• • •

Thank you for your response to my e-mail. Your e-mail does answer my biggest question. Thank you.

I’ve had a few thoughts about Apple stock that you might also expand on should you decide to cover the Apple stock topic in the future. Why hasn’t Apple split their stock again? As much as I enjoy and benefit from the price increase, it seems to me that it would do even better if it were starting from a lower base price. Wouldn’t it make sense that more people could and would invest in Apple stock if the price were more reasonable? Do you think that Apple might be thinking of buying back some of the outstanding shares with some of the huge cash reserves they have built up? Would that even make sense? I wasn’t aware that Apple had paid any dividends. I purchased my shares either in 1995 or 96 and have seen it split twice. Must have been ’96 since I never received any dividends. I hope that Michael and the editors agree that an article on the financial side of Apple is a worthy subject for ATPM and would look forward to reading it.

Thank you again for your response and your consideration of my suggestions.

—Claude Nolan

I’m working on an article covering the topics that you asked about for a future issue of ATPM.

—Robert Paul Leitao

MacMuser: It’s Got No Blinking Light
Sometimes I wonder how to find out if my iMac is really sleeping or just has the display turned off...

—Ulf

Apple’s Ghost of Christmas Yet to Come
Steve Jobs was widely credited with being the spirit and driving force behind innovation at Apple. He

1http://www.atpm.com/18.01/welcome.shtml
2http://www.postsateventide.com/p/aapl-12-month-pr ice-targets.html
4http://www.atpm.com/18.01/ipad-chronicles.shtml
is now gone. How likely is it that the team he left behind can continue the rapid and successful pace of innovation seen in the past decade? If one looks around the technology landscape, Apple has been rather unique in doing so under Jobs.

—Warren Shaw

The brilliance of Steve Jobs extended to the talent he selected to lead the company. Tim Cook, for example, is an extraordinarily talented and hardworking individual who has an impressive command of and knowledge about all things Apple.

I expect strong results from Apple over the next few years as the company’s global market expansion continues unabated.

—Robert Paul Leitao

How Did This Happen?5

Your upgrade story reminds me of one with a Windows box a couple of years ago. I had a dual-processor motherboard gathering dust in my closet and wanted a decent (not top-shelf) Windows box for some light gaming and other work-related tasks.

After six weeks and too much cash, I dropped the project, sold off all the accumulated parts, and bought a small mid-tower HP cheap. It required replacement of the power supply to power the graphics adapter, but that was easily done.

The frustration factor was significant on this project, and I doubt I’ll attempt it again...even with all of my experience building and maintaining Linux boxen.

Good story...

—Dave Thompson

Easter Island Desktop Pictures6

I’ve got a Canon EOS Rebel t1i I got second hand. I will be taking it to Thailand and shooting some new photos next month. ATPM was kind enough to publish7 my first photos of the LOS (Land of Smiles) a few years back. The camera adapter for my iPad lets me preview my photos before I send them home to my Mac Pro desktop. Awesome pictures of Easter Island!

—Grover Watson

Adobe Persuasion8

Persuasion crushed PowerPoint in ease of use both in development and presentation. Why did Adobe abandon such a great tool?

—Pete Fanarkiss

We’d love to hear your thoughts about our publication. We always welcome your comments, criticisms, suggestions, and praise. Or, if you have an opinion or announcement about the Macintosh platform in general, that’s OK too. Send your e-mail to editor@atpm.com. All mail becomes the property of ATPM and may be edited for publication.

5http://www.atpm.com/18.01/segments-how-happen.shtml
6http://www.atpm.com/18.01/desktop-pictures.shtml
8http://www.atpm.com/3.01/page10.shtml
The Best and Worst Christmas Presents

This year, because we are all grown-ups and have got most of the toys we want already, we decided to have a white elephant Christmas. This meant that we had presents to put under the tree and open after Santa had passed our house. To be honest, we did wonder how he was going to get through the door of our wood-burning stove.

Our tree this year was a work of art. After considering £60 too high for something we would use for less than a week, we made our own by weaving ivy around a conical plant support from the garden. With rosemary branches poking out to look and smell like the real thing, it was remarkably effective, especially with a large pile of Christmas presents surrounding it.

The white elephant is a North American idea, adapted for our needs. We bought gifts that could be entertaining or consumable by us all. At “present time,” we took turns selecting a gift and unwrapping it. Once we had one or more opened, we could choose to steal from someone else rather than select a new parcel.

From the start, I was getting amazing presents—the benefit of having wealthy children. However, what does an iPad owner do with a Samsung Galaxy Tab? Could I really use another copy of the Steve Jobs biography, packs of green tea, or two pairs of stereo headphones? Meanwhile, my family opened radio-controlled helicopters, bottles of vintage port, and two huge radio-controlled tanks. After an amicable shuffling around, we all settled down with our new toys.

The tanks were not what had been ordered online. They were meant to be four cheap and cheerful toys we could race around the house “shooting” one another—get hit and an LED glowed on the tank. The four had been replaced by two top-of-the-range models, complete with real firing guns, two-speed gearboxes, and the like. By Boxing Day, our garden had become the Battle of the Bulge, complete with air support from the chopper.

Meanwhile, indoors, two Mac users were coming to grips with Android. We’ve wanted to have a good long session with a different tablet, and the Galaxy is the best of the also-rans. After a confused few hours, I was getting more used to Android but, like Windows, the main impression is that the operating system keeps you at arm’s length from the computer. User choice is offered for no apparent benefit, unlike the warm and comfortable feeling one gets within the walls of Apple’s iOS. Nevertheless, as a tablet, the Samsung Galaxy Tab does most things well but is hindered by its operating system, which is clunky in many areas.

Especially when you try to connect a Galaxy Tab with a Mac or copy anything to it. Even Samsung’s Web site is a little nebulous and recommends third-party software rather than its own. After hours of experimenting and looking online for solutions, the free app Cheetah Sync seems the best solution for Mac-to-Tab connectivity, albeit working across a wireless network only.

Forget the simplicity of keeping address books, calendars, applications, photographs, and e-books automatically in sync across Macs, iPhones, and iPads unless you sign up to Google’s walled garden, which can be even more restrictive than Apple’s. This rather defeats the argument that Android is an “open” system. In reality, it’s a case of choosing Apple’s or Google’s proprietary doorways. At least choosing an iPad gives the option of both.

Just before Christmas, Seagate gave us a nasty shock. It has reduced the warranty period on its drives (many to only one year), following in the footsteps of Western Digital. In our experience, Western Digital drives have given us the most problems, especially its MyBook series; and reducing the guarantee to only two years compounded our dislike. Our best drives have been Conners and a couple of old Maxtors that just refuse to die. Conner merged with Seagate in 1996 and Maxtor in 2006; Seagate bought Samsung’s HDD business recently. At the moment, there are only three HDD manufacturers in the world: Seagate, Toshiba, and Western Digital, with the latter having the greatest market share.
Seagate Barracudas have been our default choice for SATA drives. We have had a couple of failures within its three-year warranty period, but Seagate has replaced them by return of post. It is moving all new Barracuda drives, except the Barracuda XT, to one-year guarantees. Who in his right mind will trust data to a drive that the manufacturer expects to fail after one year?

What was the other worst Christmas present? Luckily, not something I selected in the white elephant but had a taste of on Boxing Day. The product exceeds the fermented shark meat known as hákarl, beloved by Icelanders, and goes further than Gamle Ole, the year-old stinking cheese the Danes dare not have in the house. Even the putrid odour of the notorious durian has more attraction.

The product is called Baconnaise, a blend of bacon flavour and cheap mayonnaise that should be banned from European shores on the grounds of taste. Sales took off in the US after Oprah Winfrey endorsed it. Personally, I agree with Jon Stewart, another US pundit. On trying Baconnaise for the first time, he gagged and stated afterwards that it’s “for people who want to get heart disease but...are too lazy to actually make the bacon.”

Copyright © 2012 Mark Tennent².

²http://www.tennent.co.uk
The Normals’ View of Apple and the iPhone

The last Macworld Expo I attended was in January 2009. This also happened to be the last Macworld Expo Apple attended. While in the Bay Area, I and some friends took advantage of the location and made the short trip to Cupertino, and the Apple Company Store. For those who’ve never been, the Company Store differs from your average Apple retail store in that it offers a variety of Apple-branded items such as clothing, hats, and paper and office products, in addition to the hardware and software you’d expect to see. I left with a black fleece pullover with a silver Apple logo on the left breast (on clearance, no less).

By now you’re wondering why this is at all important, and after all, aren’t I simply bragging? The Apple fleece has become my go-to sweatshirt. It’s comfortable, and as we fashionistas all know, black goes with everything. So it’s not uncommon during the two or three days of winter we have here in north Texas to see me sporting the Apple fleece. It’s also a mainstay when I take our oldest son to the rink for hockey.

At a recent practice, a pair of fellow hockey dads were standing by the glass a few feet from me, discussing the iPhone, Apple the company, and Steve Jobs. One of them had obviously recently finished Walter Isaacson’s biography on Jobs¹, given some of the material he was regurgitating. This led to more material on Apple as a company, both under Jobs and without him at the helm, and about the iPhone and iPad. As I watched our sons practice and half-listened to their conversation, I was struck yet again at how differently I view the technology world, and specifically Apple and its products, from normal people.

Please understand that when I say “normal” people, it is not a term of derision, like, say, muggle. I worked in IT for a decade and a half, nearly ten of those years exclusively on Macs. You wanted to know why Mac OS 8 wasn’t behaving properly once the Finder appeared on screen after boot? Why, you may well have a rogue extension or control panel installed; let’s take a look. What’s this, Mac OS X is actually based on Unix, and there’s now a command line? Oh, goody, something new to learn so we can better exploit the ease with which things can get done and we can get back to our game of Doom 3. Or Modern Warfare 3. Or whatever game’s the latest and greatest. (Because that last part is what normal people think IT people are really doing when we’re not actually working on a computer.)

As I said, I see these sort of things differently, as do many of my friends, including colleagues on this very publication. Normal people don’t buy black Apple fleece sweatshirts. And if they happen to, normal people usually don’t make a special trip out of their way to do so.

What I have noticed about wearing the fleece in the three years I’ve had it, is that fewer and fewer people will ask if I work for Apple. Or used to, if they know what my current occupation is. The why is easy to answer: today, more than ever, Apple is such an important part of people’s daily lives that it’s not an oddity any more. Apple is no longer the alternative-to-Windows company. Apple is now the iPhone company². And it seems that everywhere I look, someone’s using an iPhone.

And interacting with normal people who use iPhones, I’ve quickly learned that they use their iPhone much differently than we more-plugged-in techie types do. For instance, they usually only have one Twitter client, the official one from Twitter—if they have a Twitter client at all! <gasps, shock, horror> They don’t spend a lot of time obsessing over the latest and greatest apps, and most of the time what they have installed beyond Apple’s default apps are recommendations from friends. From my own random, completely unscientific observations of the iPhone-using normal masses, the non-Apple app I see in use the most is Facebook.

I realize that a lot of this sounds like common sense, but it’s sometimes hard for us techie types to understand how differently we see the technology world versus normal folks. Those people who just want stuff to work, just want to get stuff done so they

¹http://www.amazon.com/dp/1451648537/?tag=aboutthisparticu
²http://www.businessinsider.com/chart-of-the-day-apple-the-iphone-company-2012-1
can get on with their lives. For us, the tech stuff is our life. Those who can make the transition back and forth easily are the ones who do very well in the IT consulting arena. And, normal folks, it’s always great to have someone like that in your corner.

Copyright © 2012 Christopher Turner, cturner@atpm.com. Managing Editor Christopher Turner is no longer in the IT biz, but he has several friends who are. To his knowledge, none of them wear a black Apple fleece, but they are friendly and knowledgeable.
An Achievable Dream

The idea was to assemble all the parts necessary for me to shoot, edit, master, and distribute video productions on a completely portable system. The first proper decision was to acquire a 17-inch MacBook Pro with a 120 GB hard drive, a 2.16 GHz Core Duo, and max out the RAM at 2 GB.

I picked up a PYRO AV converter in order to be able to take on any possible source of video and audio from other recording situations. It allowed me to convert digital and analog sources to FireWire signals, which could be utilized on my MacBook Pro.

I had a professional digital video camera with FireWire output and got some Sennheiser microphones to go with it. My trusty tripod was still useful, and my lights were old but good. I had a bird’s nest of adaptors and cables from decades of production work, and I had now amassed a large collection of USB, FireWire, DVI, HDMI, and other adaptors and extensions to fit any situation I might encounter.

I saved up for 18 months to afford Final Cut Studio with all the components I would need to edit and master my video work and burn DVDs on my MacBook’s SuperDrive. Three very large external hard drives were the final parts of the project, which finalized my shopping list of needs to become a fully independent video producer. Of course, a newer version was released a month later.

At different times of my life, I’ve worked inside and even been responsible for multi-million dollar production studio facilities. I’ve done work in some of the most advanced facilities, and I’ve been fortunate to have been given access to the most current machines and techniques of video production as they were introduced. I began my career when a studio was the primary location for making television. I entered the workforce just at the time when cameras were moving from the pedestal to the shoulder. They became small enough to walk around and move toward the content instead of booking time under the lights and having the content come by for a visit.

I was extremely fortunate to have had a kind of laboratory of video equipment and mobile gear where I could experiment with different approaches to storytelling and be exposed to a lot of the innovations which were arriving all the time. After a while, I became responsible for running a studio in a large university, where materials were produced in-house for use in class.

While I was in technical school, I challenged my instructors regarding the future of television. I believed computers were going to play a significant part in the making of television. They told me it would be a very long time before people used computers in any part of making television.

I can confess that I did not find myself doing as much production as I planned for when I put together my studio-in-a-box concept. My work took a turn away from direct production, and I eventually became a consultant to others. My experience and expertise in all things media meant I was more involved in helping others do their projects than I was in doing my own. It was much more lucrative to be paid for helping others than to invest in a project that might or might not find a paying audience.

Shortly after I got my MacBook Pro, I was in Los Angeles and the motherboard died. I was able to take a day and get to the Century City Apple Store on Santa Monica Blvd where I could see a “genius” about my problem. It was my first Apple Store experience, and it was quite amazing. It was the first time I was able to observe people responding to the special qualities of the Apple product experience in a relatively normal shopping environment (as much as one can say any shopping in L.A. is the least bit normal).

My genius was very quick to determine the problem and immediately offered to take the machine and fix it within a day or two. I had to explain that I was from Canada and would have to have it fixed locally once I returned home. From what I had read at the time, my particular model of MacBook Pro was experiencing this problem a lot. Upon my return, I went to my usual Mac service people and they had
my machine turned around in a day. Since then I’ve had zero problems with the motherboard.

About a year into owning my MacBook Pro, Apple opened a retail outlet in my city with its own Genius Bar.

Over the years, I have had some other issues with my MacBook Pro. The first was quite surprising because I had absolutely no idea what my problem was. I was, by this time in my MacIntosh experience, chastened enough not to try to suss out the problem. I made an appointment and brought my MacBook Pro in for an inspection.

I had prepared a full length account of what I had been up to, when things began to get wonky, and some of my own theories about what might be wrong with the machine. I sat on the stool and lifted the machine out of my case and set it on the counter. The genius immediately told me he could see my problem and he would be happy to replace my battery right then. I was flabbergasted. I pleaded with him to hear my story while he went to work keyboarding the session and ordering up a replacement battery.

But the real shock for me was when there was no charge for the visit. This was the second time that my MacBook Pro was taken in for work and there was no cost. What struck me was how observant this person was in noticing the slightest bulge of the battery on my machine. Until he pointed out the very small bulge, I could not see it. Once the replacement was out of the box and in my machine it was happy days all over again.

As I was traveling more regularly for this particular contract period than I normally did, I decided to buy a second battery and have it for those times when my machine was running low. The original battery was now replaced, and another battery was bought about three months later. When I was not traveling, the “spare” was on a shelf over my desk at home.

I had gotten pretty familiar with most of the Mac line of laptops years previous to this. My father developed a condition where he had much difficulty walking and standing, so I got him a greenish clamshell iBook to use. He learned to use e-mail, to browse for interesting things on his Internet connection, and he learned to trade stocks on his account using the iBook. After about four years of daily use, this clamshell was upgraded to a white iBook, and he continued to use it until he died in 2010.

My wife was allowed to get a white MacBook on a technology allowance at her work and became somewhat familiar with it. My son ended up using my wife’s MacBook for most of his high school years. When he started university, I bought him a nice new MacBook Pro with the unibody aluminium frame. There was a promotion at the time for a free iPod touch. My son was not interested in the iPod touch, so I got it. It’s been in continuous use by me ever since.

My son’s approach to his MacBook Pro is to change nothing. After three years he is still running the same system it came with. I had him load Office for the Mac and a couple of other utilities, but he’s never responded to the upgrade offers, or felt he needed to move up to Snow Leopard or Lion. Only recently did he ask me to put Parallels on the machine and let him load up Windows 7 for some of his assignments.

As for me, I’ve upgraded my machine each time a new OS arrived on store shelves, and I’ve kept all of my utilities, applications, and widgets up-to-date. My MacBook Pro is not capable of running Lion, and there are one or two other limitations emerging, which will require me to address its future fairly soon. I continue to Time Machine my data and stay aware of issues of security and new features. I think this is still a throwback to when I was running an unstable machine and needed to feel I could handle any problem.

Right now my machine sports a large dent on one corner of the lid where it made contact with some concrete stairs when I missed a step and stumbled. My computer briefcase is leather, and I use a shoulder strap mostly when carrying it. I hurt myself somewhat when I stumbled, and I did not really notice my computer bag at the time. In fact it was not until a few days later that I noticed the dent on the machine. I had been using it constantly over those days and did not really observe the lid closely until the weekend. I immediately imagined that my son had borrowed it somehow and put a dent in it, but I quickly dismissed that (as much as I wanted to blame someone else) and it took me some time before I could reconstruct my movements of the past few days to make the connection between my stumble and the dent. The machine usually travels in the briefcase in sleep-mode, and there was no damage to any of the data. This MacBook continues to impress me even as it gets older.
My contract work required me to get Parallels for the Mac, and it came with a companion disc of Windows XP as part of the sales promotion. I was able to operate within a large government ministry entirely outfitted with IBM desktop machines and IBM laptops (as well as Lenovo tablet PCs) and access their networks and servers as well as SharePoint and Exchange systems with no trouble at all. It was also helpful for the MacBook Pro to be able to switch back and forth between systems so I could use my more powerful Macintosh software when I needed it. As far as anyone wandering by my desk knew, I was running a version of WinXP on my aluminium laptop. Very few people noticed that it was a Mac. But when they did it started some interesting conversations about how they would prefer to use one or how they got one for their son or daughter because it was a better machine for school.

My MacBook Pro did make a few video projects, and once I was editing some video on my laptop in this government office when someone noticed this. They were amazed that I was able to handle the video and audio right there on my portable machine. They were also amazed later when the video played in a board room on the hi-res projector and it looked fantastic. I delivered a DVD master for three different video projects in that contract, and they were duplicated and distributed across the entire ministry.

The only other technical mystery related to owning my MacBook Pro was when my household Wi-Fi connection would occasionally fail me. I would be working away quite normally, and suddenly the Wi-Fi would drop out for no particular reason. This re-animated the “old me,” who was determined to suss out this problem for himself. I spent more than three months trying to narrow down this problem. I worried about the operating temperature of the MacBook Pro getting too high if I was doing complex work. But that wasn’t it. My machine would drop the wireless link even when it was cold. And I even investigated nearby wireless signals that might interfere with mine. But it did not reveal any conclusions. I ran test after test and worked for a long time on my own before I went to my local Apple genius to see what they could do.

Of course, the machine operated perfectly at the store on their network. As much as I might explain, they just could not reproduce the problem. But they did suggest that my wireless chip might have an intermittent problem and they would be happy to replace it. So I did.

After about a week of having a more normal network connection, the drop outs started up again. It was during one of those frustrating afternoons where I’d finally resolved to close the lid on this machine for the rest of the day that I literally put my finger on the problem. After closing the top of the laptop, I stood up from my chair and touched the sleeping machine as I stepped away from the desk. I felt a current on the outside of the computer which I had not noticed before. I wondered what was causing this. I knew from my vast experience with electronics of all kinds that sometimes when the “ground” of an electrical connection is “lifted”—or gets severed—a trace of the current will be conducted to the metal the device is made with.

When I noticed the slight current with my finger, I turned my attention to the power chain. My household outlets had all been upgraded two years before with a top-to-bottom re-wiring of my house (which included a lighting strike protection circuit for the whole house). So, I had some confidence that the wall outlet was likely not the problem. Then I turned to the power bar, which connects AC to all my devices on this desk. When I pulled the cord out for the MacBook Pro adaptor, the current on the laptop vanished. When I plugged it back in, it returned. So then I checked the MagSafe connection, and when it was out the current was not there; back into the socket and the current returned.

Fortunately I had bought a spare power supply some years back, when I realized I would be better off to leave one at the office and keep one at home. The next day I brought home the office power adaptor and substituted it for the previous one. Magically, there was no longer any current traveling through the metal case. I had solved this problem a little too late to save myself some money, but essentially the un-grounded electrical connection was generating a field which was blocking the Wi-Fi signal just enough through the case of the MacBook Pro to have it drop out fairly randomly. With a new power adaptor in hand, I returned to my desk and replaced the faulty one. Ever after I have had no trouble whatsoever keeping and holding a wireless network connection.
About a week later, I went to swap my battery for the “spare” I kept on the shelf and found it was popped open. This was the “newer” of the two I owned. I had written the purchase date on the plastic of each of my batteries to distinguish them from each other.

A couple of days later I walked into my local Apple store (having made my appointment online) and slapped down this bursting battery. It was the only time I encountered some resistance from them regarding my product failures. But after assuring them that I in no way caused this battery to burst and pressing them to “do the right thing” they eventually replaced it. So now I had replaced two separate MacBook Pro batteries at no cost.

This is—for me—a hallmark of the Apple experience. Fully aware that if I owned a different kind of computer or laptop I would never have been given the kind of service I got from the Apple Store, I am more than just a little eager to show off my now aging MacBook Pro and tell tales of how they’ve kept me going.

I’ve heard stories from people who’ve broken an iPhone or dunked an iPod and taken them for examination by an Apple genius. In these stories, it is told that the genius has considerable latitude in deciding whether the “story” being told is an interesting one or is credible, and Apple encourages them to keep the customer happy—even if it means a little bit of cost to the company.

I can certainly testify to how happy I’ve been with my adventures in laptop computing when it came to getting service from my Apple Store (and one other). And this takes me right back to my first encounter with an Apple IIe, where I developed more and more confidence in both the idea of relying on computers to do important work as well as enjoying the experience and being delighted by the whimsical approach Apple took to dealing with the user experience. Each of the Macintosh machines I’ve used has been yet another advancement of my capabilities and a realization of my larger dream of utilizing the power of computers in my every day work.

This is a continuation of the story begun in last month’s How Did This Happen? Copyright © 2012 Dave Trautman. Dave is a Media Specialist working in Canada, with a special background in Media Effects, who has been using a Macintosh computer since 1988. The Segments section is open to anyone. If you have something interesting to say about life with your Mac, write us.

1http://www.atpm.com/18.01/segments-how-happen.shtml
Digital > Analog > Digital

If you are connected to me via one of numerous social media channels, you’re likely aware of my disdain of QR codes. There’s only one use I find to be helpful: embed a lot of contact information into one and print it on a business card. This allows me to quickly set up a contact in my iPhone. I scan the code and import a vCard instead of manually (and slowly) entering a name, e-mail address, Web address, phone number, fax number, and physical address, ad nauseam.

vCards aside, nearly every QR code I encounter simply pushes a Web address. Though I’m aware that plenty of people feel differently, I can generally always open my iPhone Web browser and tap out a URL faster than I can open a QR scanner app, wait for the camera to wake up, scan the code, wait for translation, tap the link, and let the Web browser take over to load the page.

I’ve been asked, but what about long URLs such as:

www2.fooblahfooflah.co.uk/?id=1234&dumb=sk30s&lotsmoreURLoperators

Simple: if you have marketed a URL that’s much more than yourURL.com/something, then you’re doing it wrong.

Fine, people enjoy scanning those ugly squares (a graphic designer’s nightmare), so I concede they’ll be printed on stuff for a long time to come. Thankfully, it doesn’t mean I have to scan them.

There is, however, a new problem. The entire point of QR codes is to bridge the physical/analog world with the online/digital world. They provide a means, on a physical object (e.g. paper), to connect you to something online. But, the QR code fad has grown faster than people’s understanding of them. As a result, they have crept into venues in which they do not belong—Web pages, social media profiles, etc.

A recent example is Firehouse Subs’ Twitter page¹. At this moment, the page has two QR codes as part the background image, which link to their mobile apps for iOS and Android. Don’t get me wrong, a Firehouse sub with the founder’s datil pepper sauce is a party in my mouth. Nevertheless, to see QR codes on a Web page is foolish.

Why?

Before I answer, I must make the observation that the design of Firehouse Subs’ Twitter page leaves profile content covering over the QR codes, so they can’t be seen or scanned unless you have your browser window stretched wider than the Mississippi River.

But, if we assume a Web content worker ensures the QR code is visible, why not instead provide a hyperlink to click or tap?

Put another way, a QR code on a Web page as a means to link to another Web page is like duplicating a digital music CD to an analog audiocassette, then digitizing it back to a new CD. Obviously, the correct procedure would instead be to digitally copy the CD directly. Likewise with Web pages, the visitor is already in the digital world. A plain hyperlink to click will do just fine.

So, here’s my month-late New Year’s resolution for Web content workers: if you need to use a pretty graphic link instead of a plain text link, so be it, but resist the fad-driven urge to place URL-loaded QR codes on Web pages.

¹http://twitter.com/firehousesubs

Copyright © 2012 Lee Bennett. The Segments section is open to anyone. If you have something interesting to say about life with your Mac, write us.
Smart Move?

I use Macs and an iPad for all my personal computing. For mobile music listening, I have an iPod shuffle, mostly because both a 10 GB iPod and an iPod touch died on me. I got my brother and one of my sisters to go Mac, too, which means less tech support work for me. Recently, I finally made the leap to having a smartphone, and I ended up with an Android phone— to be exact, a Samsung Galaxy S. What? Why not an iPhone? It mostly came down to inertia and money.

Change is a constant in life, but there is also inertia. Changes do not always happen drastically but sometimes gradually. That is the case with me and mobile phones. Much as I love computers, the love does not translate readily to mobile phones. As a matter of fact, it was only when my wife was pregnant with our child that I got my first cell phone, some time in the late 1990s.

It took another ten years or so for me to move up to a smartphone. By then I already had an unhappy stint with AT&T, followed by many years with T-Mobile. I also have a family plan for three phones. Much as I'd love to take advice from Siri, I could not easily leave T-Mobile. I pay my bill online, so the idea of having a new user name and password to memorize, or even entered into 1Password and such, is not attractive.

It did not help that AT&T's service continues to be deplorable, at least according to what friends tell me. I suppose I could have taken the leap to Verizon, but Verizon in general is more expensive. Ah, it usually comes down to money. With the T-Mobile deal I took, the data plan was only $10/month for 200 MB. When you don’t download audio or video, 200 MB a month is actually sufficient. I might be able to get data plans from other companies for $15/month but the $5 difference multiplied by 3 still puts the month’s extra cost at $15.

The iPhones 4S sure would be nice to have, but it costs in the hundreds of dollars, even with a two-year contract. Again, so that none of the three adults feel slighted, I would have to get three iPhones. In these uncertain economic times, with every price on most things on the rise while salary remains the same, I need to cut every corner I can.

So inertia and money are the underlying reasons for me not going with the iPhone. The many restrictions AT&T and Apple force upon the iPhone users also are turn-offs. Even with the few dumb phones I had in the past, I was able to set different songs as ringtones. Nothing to buy, no workarounds, just whatever songs I already own and have stored on the Mac. Yes, it is a pain to transfer the songs via Bluetooth, but it does not happen that often so the experience is tolerable.

With my 200 MB/month plan, there is not enough bandwidth to share with other devices. Still, should I want to, I have the ability to turn my unattractive smartphone into a hotspot to allow nearby devices access to the Internet, anywhere the T-Mobile signal is available. The ability is there in the iPhone, provided you jailbreak it. The game of cat-and-mouse some people put up with for jailbreaking just does not work for me. I want a phone that works as a phone unless I accidentally make it unworkable, not because some OS update.

I saved some money by not going with the iPhone, but is it a good user experience? No, it is probably like being at an unhappy job or flying coach. You get the regular paycheck or you get to your destination, but it is not pleasant. The phone reps pre-loaded a bunch of apps for me, and I think it may not be a good thing.

There were two versions of the Facebook app, one of which always reminds me to download the latest version. I complied only to be told again the next time it launched.

---

1[^1]: [http://www.atpm.com/18.02/create-iphone-ringtones.shtml](http://www.atpm.com/18.02/create-iphone-ringtones.shtml)
One of the Facebook versions that annoys me by prompting for download of newer version each time it starts.

I still use Plurk, a minor competitor to Twitter, and its Android app actually relies on the alternative Web browser Maxthon. The Plurk app also keeps telling me to download the latest version.

Most of the app icons look crude compared to the typical icon in iOS. Least acceptable are the T-Mobile apps MyDevice and MyAccount, as they look very unattractive. Last but not least, there is a Files app, which lets you walk the folders and see all the files in the phone, most with geeky names. The Camera app stores its files in a folder called Camera, which is inside another folder called DCIM. DCIM? Totally intuitive, no?

Yellow folders, just like on the desktop. I prefer iOS’s hiding of these desktop artifacts.

I would not be surprised if there were a text editor for Android for the geeks out there to happily edit configuration files by hand instead of through the GUI. I think this approach of bringing the desktop folder structure to the smartphone is just a disaster waiting to happen. What safeguards are there to prevent someone from deleting system files? I am not going to try that on my own phone.

Life is full of compromises. Money, ease of use, geeky functions, and features. In my case, I make do with a functioning smartphone that serves me well for e-mail and Facebook at a nominal cost. Perhaps some day I’ll come across a pile of money, or the kids will leave the nest so I can have my own phone plan and can splurge on an iPhone.

Copyright © 2012 Linus Ly. The Segments section is open to anyone. If you have something interesting to say about life with your Mac, write us.
Create Your Own iPhone Ringtones

In the summer of 2010, I parted with my old Palm phone and entered the fraternity of iPhone owners. I could have waited to see if other carriers got the iPhone—which they did mere months later—before making the leap, but the Centro phone no longer played nice with my Mac. Each attempt to sync calendars and contacts was a laborious, time-consuming ordeal.

Normally, when I buy a new electronic toy I dive right in, push every button, and try every feature. I didn’t do that with the iPhone 3GS. I’ve never been one to use a lot of data or multimedia on my phone. It’s nice to have the option to do so, though. Until recently I hadn’t even bothered to investigate how to create custom ringtones on my phone. It’s not that I expected creating ringtones to be difficult but that it was just a low priority for me.

Why the Sudden Interest in Ringtones?

I’ve only had four or five different cell phones since the mid-nineties, and none of them have made it especially difficult to add new ringtones. In spite of that, I haven’t felt the need to add new sounds. So, given my less than burning desire for new ringtones, why investigate that now?

Recently, over a period of several days I seemed to run across an unusual number of forum threads similar to this one, asking what was needed to create custom ringtones. The answers often included links to sites where ringtones could be purchased or links to third-party software such as iPhone Ringtone Creator or YouTones. Personally, I’ve got nothing against either method of getting custom ringtones, but this seems to fit right in with our ongoing theme of investigating existing Mac software when starting a project before purchasing new third-party software. This process, while not uniquely mine, is easy enough that anyone can do it. Let’s open the lab and get right to work.

Gather Your Tools

You don’t need any special tools for this project. Essentially we’re taking a portion of a sound file on your Mac and converting it to a format that the iPhone recognizes as a ringtone. In fact, all you really need are:

1. A few sound files that you want to convert to ringtones. I’ll be using files from my existing iTunes library, but you can add any sound iTunes can play properly. These directions were written with DRM-free sounds in mind. If you’re going to be working with iTunes Music Store files that still contain DRM, give these directions a try.

2. iTunes (or other software capable of creating AAC files).

3. An iPhone. I used my iPhone 3GS for this experiment, but I have seen reports that this process works with older iPhones as well.

If you would like to have more precise control over the final sound than iTunes provides, GarageBand will do the trick. In fact, any sound editor capable of saving files in AAC format, including many free ones, should do nicely.

Now that we have the right tools, let’s get down to work. We’ll start by creating a new folder that we can drag the new ringtones into. Unless you choose to delete the folder later, you’ll only have to do this once. Creating this folder gives us a convenient place to store the new ringtones until we are ready to import them. I placed my folder on the desktop, but it could be anywhere.

Before we create any new sounds, let’s make sure iTunes is configured properly. Launch iTunes and go
to the Music section of your library. Right-click a song that’s DRM-free. When the contextual menu appears, examine the listed options. If one of them says “Create AAC version,” you’re ready to start. Some versions of iTunes have “Convert Selection to AAC” listed. The exact wording isn’t important as long as iTunes is converting sounds to AAC format. If you already have one of these options listed, feel free skip the next paragraph.

Creating AAC Sounds

The conversion option listed in the contextual menu depends upon your chosen format for importing music. Making the format change is simple. From the iTunes Preferences window, click the General tab. Near the bottom of the window is a button called Import Settings.

Click here and wait for the next window to appear. In some versions of iTunes, this option is found in the Advanced tab and listed as “Import Using.” In either case, change the Import Using pop-up menu to “AAC Encoder.”

This setting can be reverted to your chosen format when we’ve finished creating your new ringtones.

Creating Your First Ringtone

Select the sound that you want to use as the new ringtone. You must keep your ringtones to 30 seconds or less. In iTunes, snipping that much time out of a
song is simple. Start playing a song and wait for it to reach the beginning of the segment of sound that you want to use. Make note of that time, as it's shown in iTunes. Let the sound play until you reach the end of the segment you want to use and note that time. Now do the following:

1. Right-click your chosen song and chose Get Info. In the next window, click the Options tab and place check marks by the checkboxes for the start and stop times. Enter the times you noted earlier in these boxes. Changing the volume and equalizer settings shouldn't pose a problem.

![Completed Options Tab](image)

Click OK and iTunes will use the sound segment that you just marked to create the ringtone. Don’t worry; the conversion process creates a new file rather than altering the original.

2. Right-click the sound/song again and choose “Create AAC version.” iTunes will beep when the conversion is completed. Now you can right-click your original file, go back to the Options tab, and clear the start and stop time checkboxes.

3. Once that is finished, we need to locate the new sound inside your iTunes Music folder. In recent versions of iTunes, you can do this easily by right-clicking the original song you are working on and choosing “Reveal In Finder.” This takes you directly to the appropriate folder. The new sound is usually right next to the original file.

4. Drag your new song file from its current folder to the temporary folder you created earlier. If you have difficulty identifying the new song, look at the filenames. The shortened file that will be your ringtone usually has a number at the end of the filename just before the extension (e.g. sound1.m4a). Quick Look can also be a useful tool here as well. It’s an easy way to see the file durations and sizes if needed. Change the extension of these files from .m4a to .m4r. The Finder will ask which extension you want to use. Make sure you choose .m4r.

5. At this point, we are almost done with the project. Go back into iTunes and select the shortened AAC files that you created. It’s safe to delete those now. It not absolutely necessary to remove them, but all they are really doing is cluttering up the library. If you have trouble finding the right files, go to the View menu in iTunes and select View Options. Click on the “Kind” and “Date Added” checkboxes and click OK. These columns now appear in your library. Clicking the “Date Added” heading will sort the library based upon when the files were added. The “Kind” column can be a failsafe to make sure you are deleting the correct file.

6. While we are still in iTunes, go to the File menu and choose “Add To Library.” Navigate to the temporary folder where you stored the ringtones and let iTunes add them to the library. If you are only adding one new ringtone at a time, try simply double-clicking the .m4r file you created. It will be added to the library automatically. All that is left to do now is sync your iPhone so the ringtones will transfer.
Final Thoughts
I don’t have a means of testing this at the moment, but I believe a similar process might work with other smartphones. This assumes that you know what file format and length of sound the phone expects. I am starting to wonder if it would be possible to do other things such as create new alarm sounds for iCal, but that’s a project for another day. Maybe next time. Until then, the lab is closed.

Copyright © 2012 Sylvester Roque, sroque@atpm.com.
Desktop Pictures

From ATPM Readers

We need new desktop pictures each month. Write1 to us!

This Month’s Desktop Pictures2

This month’s desktop pictures were contributed by ATPM readers:

Chris Albertson3 This is a photo I took from my window, looking East over Central Park towards the Triboro (now RFK) Bridge. It works well as a desktop, I think, because it is not a busy, distracting background.

By the way, a Mac user since 1984 (and Apple before that). I find ATPM very useful and entertaining. Thank you for that.

Mike Grossman I was inspired to visit Chaco Canyon in July 2011 after reading about this ancient Native American site in Jared Diamond’s book Collapse4: How Societies Choose To Fail Or Succeed. Having dwelt in humid, swampy Florida most of my life, this dry, sun-blasted landscape with its ruins fascinates me. It was a very important place 1,000 years ago when people lived(?) there. I wonder whether our cities, monuments, stock exchanges, cathedrals, mosques, and synagogues will be mysterious ruins 1,000 years from now, whose function will be the topic of much scholarly debate and endless conjecture by UF0logists. Perhaps the battered relics of our Apple i-devices cluttering our landfills will be interpreted as ceremonial props in a globe-spanning, fruit-worshipping religion.

Narcis Parfenti Varasti Sunset: Varasti is a village in Southern Romania I passed through only once, but I stopped the motorcycle only to capture this sunset.

Flowers: Those are the flowers in my girlfriend’s garden, which I shot with the intent of making a wallpaper. And I would like to share it with you all.

Old Boat: That actually is a reconditioned boat, but villagers in the Danube Delta still use them on a daily basis, the design hasn’t changed for hundreds of years.

Cyrus Roton Cyrus sent a collection of Navy pictures of the USS Hornet.

Contribution Your Own Desktop Pictures

If you have a picture, whether a small series or just one fabulous or funny shot, please send it to editor@atpm.com and we’ll consider publishing it in next month’s issue.

Previous Months’ Desktop Pictures

Pictures from previous months are listed in the desktop pictures archives5.

Downloading All the Pictures at Once

Some browsers can download an entire set of desktop pictures at once.

Safari Create a workflow in Automator with these three actions:

1. Get Current Webpage from Safari.
2. Get Image URLs from Webpage. Get URLs of images linked from these webpages.
3. Download URLs.

iCab Use the Download command to “Download all linked files in same folder” and configure the limits to download only the linked images.

http://www.atpm.com/18.02/atpm-readers/

1mailto:editor@atpm.com
2http://www.atpm.com/18.02/atpm-readers/
3http://www.amazon.com/dp/0670033375/?tag=aboutthis particu
4http://www.amazon.com/dp/0670033375/?tag=aboutthis particu
5http://www.atpm.com/Back/desktop-pictures.shtml
OmniWeb Choose “Save Linked Images…” from the File menu.

Placing Desktop Pictures

**Mac OS X 10.3.x Through 10.7.x**
Choose “System Preferences…” from the Apple menu, click the “Desktop & Screen Saver” button, then choose the Desktop tab. In the left-side menu, select the desktop pictures folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Select the Screen Saver tab which is also in the “Desktop & Screen Saver” System Preferences pane. If you put the ATPM pictures in your Pictures folder, click on the Pictures Folder in the list of screen savers. Otherwise, click Choose Folder to tell the screen saver which pictures to use.

**Mac OS X 10.1.x and 10.2.x**
Choose “System Preferences…” from the Apple menu and click the Desktop button. With the pop-up menu, select the desktop pictures folder you want to use.

You can also use the pictures with Mac OS X’s built-in screen saver. Choose “System Preferences…” from the Apple menu. Click the Screen Saver (10.1.x) or Screen Effects (10.2.x) button. Then click on Custom Slide Show in the list of screen savers. If you put the ATPM pictures in your Pictures folder, you’re all set. Otherwise, click Configure to tell the screen saver which pictures to use.

**Mac OS X 10.0.x**
Switch to the Finder. Choose “Preferences…” from the “Finder” menu. Click on the “Select Picture…” button on the right. In the Open Panel, select the desktop picture you want to use. The panel defaults to your ~/Library/Desktop Pictures folder. Close the “Finder Preferences” window when you are done.
Lisa, where's your homework?

My virtua-Dog App ate it, Miss!
Junk information is as toxic as junk food. As a group, Americans are fat. Our diets are out of control: we eat too much and, Clay Johnson explains, we take in too much in other ways. This book is his attempt to convince you of that and to recommend for how to curb our intake.

Johnson examines obesity and our cravings for fat, salt, and sugar, and says that our information choices lead us down the same paths: we look for opinions, facts, and treatments that agree with what we already believe. It makes us feel good to have affirmation. Over time, we avoid topics and opinions very different from our own, or we tend to approach them only to argue, to reinforce our current and long-held positions. This is called “confirmation bias.” Its danger is that we rarely get exposed to anything new, and rarely revise our positions. “It’s too high of a cognitive and ego burden to surround ourselves with people that we disagree with,” Johnson writes.

Search Engine Optimization

Johnson’s look at news organizations includes an explanation of how headlines are crafted. Most online sites are forced to construct headlines that will get you to click on them, regardless of their relationship to the story content. We call this search engine optimization (SEO)—I work for a daily newspaper with an online component—and its purpose is to get you to click on stories so that we can show our advertisers that people are seeing their ads. All online news organizations participate in this SEO effort to varying degrees.

Johnson talks about the spectrum of TV news stretching from Fox to CNN to MSNBC, explaining how they got to their political positions and why making the news choices they do works for them.

After he sets up the problem, Johnson provides strategies for how to change our information diet. The strategies require a sense of humor and willpower. I was amused that one of the tactics for sharing the ideas in the book was to join a local online group, which would be just one more way to be online, but then he encourages us to meet face-to-face, so I got it. But still...

Pragmatism

I recognized my favorite branch of philosophy near the end of the book: “Most of us give too much weight to information that’s not actionable and relevant to our daily lives,” Johnson states. In this section, Johnson is encouraging us to forego international news for local news. I was reminded of John Dewey’s and William James’ brand of thinking called pragmatism—the only uniquely American contribution to philosophy. The idea is that we don’t waste
energy working out how many angels can dance on the head of a pin, unless it affects our daily lives in some way. Spend energy only on things that matter. On this, I agree with Johnson one hundred percent.

I got bogged down toward the end of the book when he got political, as will many non-American readers. He is clear about his background in politics, so this is not a surprise, nor is it inappropriate. I admire that he makes a call to action, and many readers will appreciate the routes he suggests to make things better.

But I think most of the point of fixing this is just about each of us choosing to turn off the darn computer/phone/mobile device more often. To be clear, I am also reading a book about how we think about food, which advocates mindful eating—basically, slowing down and appreciating the moment we’re in, rather than rushing to get to the next, better one. The ideas in this book (Savor: Mindful Eating, Mindful Life by Thich Nhat Hanh and Dr. Lilian Cheung) will fit with the modifications of both food and information diets.

**Recommendations**

The *Information Diet* is a good introduction to the idea of turning off the noise, but it can go further in future editions.

I think this book would have been more effective with a few more strategies for changing our information diets. Johnson encourages readers to visit his Web site for an ongoing discussion, and the blog and forums do indeed have more ideas. But again, I am faced with the dilemma of spending more time online to find out how not to spend so much time online.

Dr. Andrew Weil recommended news fasts years ago. Even though I work at a daily paper, I have been on such a fast for at least 20 years, spending almost no time on TV news except for very rare events. There is a desperation about television; TV producers they want you not to change the channel. That makes it hard to take for some of us. I suggest trying a one-day news fast and then expanding it, is my suggestion. Johnson suggests ditching cable altogether, which I saluted, though I won’t be going down that path just yet. A friend of mine recently moved and didn’t buy cable TV, and he’s thrilled with his newfound savings in money and time. He’s discovering several great TV shows on disc a few years after they’ve aired, and he’s enjoying himself far more than before.

*Copyright © 2012 Ellyn Ritterskamp. Reviewing in *ATPM is open to anyone. If you’re interested, write to us at reviews@atpm.com.*
MacJournal 6.0

Function: Journaling.
Developer: Mariner Software.
Price: $40; $20 (upgrade).
Requirements: Mac OS X 10.6.8.
Trial: Fully-featured (15 days).

Journals. Every writer needs one, but most people who journal aren’t writers. I guess that the best journaling program would be one that has the flexibility to accommodate both. It would have word count goals and timed writing sessions; interface with popular blogging formats; import text, graphics, audio, video, and Web pages; and keep everything organized so I don’t have to. MacJournal does all these things and more. It is a powerful, flexible, and easy to use journaling environment.

Getting Started

A New Journal

The basic blocks of MacJournal are journals and entries, with journals functioning as books, and entries as pages within a book. Getting started is simple. Each new document opens with one blank entry. Select the entry and start typing. The info bar directly above the text shows the “topic” of the entry—really, the title. This defaults to the date and time,

but you can change it to whatever you want. When you’re done, save. The first time you save you will create a document that will hold all your journals. At this point you have a simple date-based diary (a.k.a. journal) where you can add new entries each day. Not much different than paper and pen...yet.

An Entry Takes Shape

Getting Organized

Chances are, though, that you’re going to want to create several journals for various topics. Creating journals is easy. Either right-click in the left bar under the default journal or select New Journal from the File menu. The number and variety of journals is limited only by your imagination. I’ve been living and working with MacJournal for over two weeks, so as an example, I’d like to show you what I’ve done.

I’ve created a total of six journals so far. The first one, which I’ve titled Projects, contains all my current writing projects, the latest of which is this review. Let’s look at the most recent entry titled “MacJournal Review” (which you are reading at the moment). Looking at the entry, I can see the date and time I began writing it (January 23, 2012 at 2:28 PM). If I select the information icon (labeled “i”), I open up the inspector window. Here I can set the status (at this point: underway), the priority (1), the

1 http://www.marinersoftware.com/products/macjournal
deadline (midnight, though I don’t plan on being up that late), and a word goal (1,000—almost halfway there). As you can see, there are lots of other options that I won’t go into here.

To give you some ideas of what other uses I’ve found for MacJournal, let’s go back to the left part of the window. Under Projects, I have journals titled Press, containing the press releases for my most recent publications (planning to put a lot more in here); Calls, containing calls for submissions with upcoming deadlines; Writing Quota, where I type a minimum of 300 words each day to keep my writing flowing; Family, containing personal entries about my wife and daughter; and Blogs.

This is just a small sample of what could be included in a MacJournal document.

Going Public
MacJournal offers various ways to interact with the outside world. In addition to text, you can import graphics, audio, video, and Web pages. All of these elements retain full functionality within MacJournal. Here are a few examples of how I have used these features:

Magazines and anthologies post calls for works continuously. Sometimes these calls are ongoing, but mostly they have specific topics and deadlines. I have a huge pile of bookmarks in my Web browser that I try to keep track of, but inevitably I miss one here or there. So I created a journal titled Calls in which I’ve imported Web pages listing some upcoming submission deadlines I’m hoping to make. In each case, I select New Entry From the File menu and chose Web Page. A window opens, asking me to enter the URL of the Web page. I copy and paste the link and press Return. Then I select OK, and the Web page loads directly into the edit window. Of course, the page can’t be edited any more than it could be in a browser, but otherwise it is fully functional.

MacJournal doesn’t stop at downloading individual Web pages. I also downloaded both of my WordPress blogs. To start, select Blog Settings under Journal. A dialog box opens, asking for the blog address, username, and password. (If you don’t have a blog, MacJournal walks you through setting one
up in Blogger, WordPress, LiveJournal, TypePad, or Tumblr.) Once connected, select Download Entries and your entire blog will appear as a new journal, complete with dates and times for each entry.

You can also blog from MacJournal. Once connected, any entries you create can be uploaded to your blog and posted immediately. I prefer working through WordPress, but everyone is different.

Keeping Private

The traditional paper diary comes with a lock for good reason. We record our most private thoughts and feelings, and we want to keep them secure. MacJournal lets you individually lock journals with a password by either right-clicking the journal and selecting Lock Journal or by selecting Lock Journal from the Journal menu. Once locked, the journal can also be encrypted for increased security. Simply select the journal. The password entry box includes options to encrypt and always encrypt.

Writing Without Distractions

But none of this matters if you’re not writing something, and sometimes the fanciest bells and whistles get in the way. So like many other writing applications, MacJournal includes a “Focused Editing” mode, which defaults to a terminal-style text-only interface. Click the Enter Focused Editing button on the top toolbar (or select View → Enter Focused Editing) and start typing. When you’re done, press the Esc key to return to your normal screen.

So Many Possibilities

I have only touched upon a fraction of what MacJournal is capable of. One of the big additions to version 6.0 is the Timeline view, which is very nice, but I don’t see myself using it.

That’s me, though. Many other people will find many other possible uses for this software. The
video tutorial lists some of these, including “medical records, flight itineraries, homework assignments, and project management information.” The examples I’ve listed are all related to my writing career. With a different set of interests, I could come up with a completely different set of examples that still wouldn’t come close to exhausting the versatility of this journaling environment.

Copyright © 2012 David Ozab. Reviewing in ATPM is open to anyone. If you’re interested, write to us at reviews@atpm.com.
FAQ: Frequently Asked Questions

What Is ATPM?
About This Particular Macintosh (ATPM) is, among other things, a monthly Internet magazine or “e-zine.” ATPM was created to celebrate the personal computing experience. For us this means the most personal of all personal computers—the Apple Macintosh. About This Particular Macintosh is intended to be about your Macintosh, our Macintoshs, and the creative, personal ideas and experiences of everyone who uses a Mac. We hope that we will continue to be faithful to our mission.

Are You Looking for New Staff Members?
ATPM is looking to add more regular reviewers to our staff. Though all positions with About This Particular Macintosh are volunteer, reviewing is a great way to share your product knowledge and experience with fellow members of the Macintosh community. If you’re interested, contact ATPM’s Reviews Editor, Paul Fatula.

How Can I Subscribe to ATPM?
Visit the subscriptions page.

Which Format Is Best for Me?
- The Online Webzine edition is for people who want to view ATPM in their Web browser, while connected to the Internet. It provides sharp text, lots of navigation options, and live links to ATPM back issues and other Web pages.
- The Offline Webzine is an HTML version of ATPM that is formatted for viewing offline and made available in a Mac OS X disk image. The graphics, content, and navigation elements are the same as with the Online Webzine, but you can view it without being connected to the Internet. It requires a Web browser.
- The Print PDF edition is saved in Adobe PDF format. It has a two-column layout with smaller text and higher-resolution graphics that are optimized for printing. It may be viewed online in a browser, or downloaded and viewed in Apple’s Preview or Adobe Reader on Macintosh or Windows. PDFs may be magnified to any size and searched with ease.
- The Screen PDF edition is also saved in Adobe PDF format. It’s a one-column layout with larger text that’s optimized for reading on-screen.

How Can I Submit Cover Art?
We enjoy the opportunity to display new, original cover art every month. We’re also very proud of the people who have come forward to offer us cover art for each issue. If you’re a Macintosh artist and interested in preparing a cover for ATPM, please e-mail us. The way the process works is pretty simple. As soon as we have a topic or theme for the upcoming issue we let you know about it. Then, it’s up to you. We do not pay for cover art but we are an international publication with a broad readership and we give appropriate credit alongside your work. There’s space for an e-mail address and a Web page URL, too. Write to editor@atpm.com for more information.

How Can I Send a Letter to the Editor?
Got a comment about an article that you read in ATPM? Is there something you’d like us to write about in a future issue? We’d love to hear from you. Send your e-mail to editor@atpm.com. We often publish the e-mail that comes our way.

How Can I Contribute to ATPM?
There are several sections of ATPM to which readers frequently contribute:

Segments: Slices from the Macintosh Life
This is one of our most successful spaces and one of our favorite places. We think of it as kind of the ATPM “guest room.” This is where we will publish that sentimental Macintosh story that you promised yourself you would one day write. It’s that special place in ATPM that’s specifically designated for your stories. We’d really like to hear from you. Several Segments contributors have gone on to become ATPM columnists. Send your stuff to editor@atpm.com.

Hardware and Software Reviews
ATPM publishes hardware and software reviews. However, we do things in a rather unique way.
jargon can be useful to engineers but is not always a help to most Mac users. We like reviews that inform our readers about how a particular piece of hardware or software will help their Macintosh lives. We want them to know what works, how it may help them in their work, and how strongly we recommend it. Please contact our reviews editor³, before you begin writing, if you have a piece of hardware or software that you’d like to review.

**Which Products Have You Reviewed?**
Check our reviews index⁴ for the complete list.

**What is Your Rating Scale?**
ATPM uses the following ratings (in order from best to worst): Excellent, Very Nice, Good, Okay, Rotten. Products rated Good or better are ones that we recommend. Okay products get the job done. We recommend avoiding Rotten products.

**Will You Review My Product?**
If you or your company has a product that you’d like to see reviewed, send a copy our way. We’re always looking for interesting pieces of software to try out. Contact reviews@atpm.com for shipping information. You can send press releases to news@atpm.com.

**Where Can I Find Back Issues of ATPM?**
Back issues⁵ of ATPM, dating since April 1995, are available in DOCMaker stand-alone format and as PDF. In addition, all issues since ATPM 2.05 (May 1996) are available in HTML format.

**What If My Question Isn’t Answered Above?**
We hope by now that you’ve found what you’re looking for (We can’t imagine there’s something else about ATPM that you’d like to know.). But just in case you’ve read this far (We appreciate your tenacity.) and still haven’t found that little piece of information about ATPM that you came here to find, please feel free to e-mail us at (You guessed it.) editor@atpm.com.

³mailto:reviews@atpm.com
⁴http://www.atpm.com/reviews/
⁵http://www.atpm.com/Back/